How to Make the Most of the 4-H Common Measures Impact Report
Template
Thanks to all of you who are using 4-H Common Measures as part of you 4-H programming! To
help you make the most of the data you’ve collected, a reporting template has been developed
to help you to easily upload a Qualtrics data file into a web application, and with a click of a
button, create a summary report. This document is a guide for how to make best use of this
reporting template.

The Report Template Webpage

The webpage to create your report can be accessed at http://walsh-lab.sfcs.cals.arizona.edu/4H
(or the shortcut http://go.unl.edu/cmreportingtemplate can be used)
The page at this link will help you upload data and create a report using Qualtrics data. If you
are comfortable with the Qualtrics reporting tools, you may instead elect to use the Qualtrics
reporting tools to create a custom report to your exact specifications. If you prefer to generate
a report automatically, the tool on this webpage will provide a standard summary report.
1. Downloading Raw Data from Qualtrics

In order to use this tool, you will first need to download the results of your survey from
Qualtrics into a CSV format. For instructions on how to download your data, please refer to the
Qualtrics documentation here
(http://www.qualtrics.com/university/researchsuite/reporting/download-data/downloadingsurvey-data/).
When you download your data, you must download it in the CSV (Comma Separated Values) file
type. During this process, please ensure that you select Choice Text for the Show Answers As
option in Qualtrics. If you select the Coded Values option instead of Choice Text, your report
will display numbers for respondent answer choices rather than phrases. (Please note, when
utilizing the Report Template only one Qualtrics CSV file can be used to generate a report. If
you would like to summarize multiple 4-H program data files together in one impact report, you
will need to manually merge this data into a single data file prior to using the Report Template
web application).
2. Report Template Webpage Requested Fields

On the Report Template webpage, you will enter the name of your 4-H Program, which will
appear on the Cover Page of the report and as a running footer. You will also need to designate
a Program Date. It is suggested that you enter the date range that the program ran, be it one
course, or data covering a year’s worth of courses; that way you have a quick reference for
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what data range of 4-H programs are covered in the report. Any fields left blank on the
Reporting Template Webpage will remain blank on the generated Summary Report. Edits to
the date and title can be modified and edited after the summary report has been generated.
3. Uploading Qualtrics CSV Data File into Report Template Webpage

You will then upload your Qualtrics CSV data file. As a reminder, the uploaded data file must
originate from Qualtrics and be a Choice Text, Comma Separated Values (CSV) file type. All
questions included in your CSV file will be included in your generated summary report.
4. Uploading a Custom Cover Page Image

If you wish, you also have the option to upload a cover page image. If you do not upload a cover
page image, a high resolution image provided by National 4-H will appear on the cover page of
the report. For best results, the cover image you choose should be a landscape orientation
image of high resolution. Images above at least one megapixel in resolution are a good choice.
Your cover image will be automatically cropped and resized as necessary to fit within the cover
page. You may use the image format of your choice, though best results will be with JPEG or
PNG format.
5. Uploading a Custom Logo

The 4-H Common Measures logo will also appear on the Cover Page of the report, and you may
choose to upload an additional logo that represents your 4-H program or Land-grant University.
The logo image you choose should be a high-resolution copy of your program or Lang-grant
University’s logo. It will be resized as necessary to fit in the appropriate location.
Once you have named your program and uploaded your data, and possibly an image and/or
logo, simply press the “Build Report Template” button and your report will appear.

Your Report

After you build your report, either the report will appear or a box asking you to save your
report file. The file will be named with the text you entered for “Program Name.” Once open or
saved, you may continue to edit your report. The remainder of this document provides tips and
guidance on how to adjust or edit your report.

Report Sections
1. Cover Page
Each report will have a Cover Page which will contain an image on the top half of the page,
either the standard 4-H image or an image you have uploaded. Text in the middle of the Cover
page will consist of the Program Name you have entered, the standard text “4-H Common
Measures Impact Report”, then the Program Date you entered on the creation webpage. You
may make edits to this text as needed. Below this text will be either one or two logos; the
standard 4-H Common Measures logo and any logo you uploaded on the creation webpage.
2. Introduction
The top of page two will be labeled “Introduction” and will contain standard text created by
National 4-H. You may add to this text if needed to better describe your 4-H program.
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3. Demographics
This paragraph will contain information summarized from your data, e.g., the # of participants
(youth) who were in your program, participant characteristics, the program name, etc. Portions
of this text are “piped in” from your data file so that you will not need to summarize this
information yourself. (Figures in the latter end of the report will also present participant
characteristics so you may choose to delete those latter figures, if you feel the introductory
section is a sufficient description of your program participants.)
4. Figures
At the end of the participant paragraph will be the sentence, “Results are shown in the figures
that follow”. The figures that follow will summarize your 4-H program participants’ responses to
each question from the Common Measures included on your survey. Below is an example of a
figure that represents a single item from the Common Measures.
How many years have you
been participating in 4-H?

100%
80%
60%
40%
20%
0%

25%

50%

25%

This is my first year
This is my second year
Three or more years

When possible, more than one survey question is summarized in a single figure to reduce the
length of the report. These figures include horizontal bars, and some readers may have
difficulty interpreting these figures. A suggestion for the report is to add a tip on how to read
these figures. For example, see the figure below and the note included below the figure.
As a result of my experience in this 4-H program or project …
Strongly Agree

Agree

Disagree

Strongly Disagree

I like to see how things are made or invented
I like experimenting and testing ideas
I want to learn more about science.
I do science activities that are not for school
I would like to have a job related to science
I am good at science
I like science
I get excited about new discoveries
0%

10% 20% 30% 40% 50% 60% 70% 80% 90% 100%

How to read the figure above: The first row in the figure above shows that 38% of participants “strongly agreed”
that as a result of their experience in this 4-H program, “I like to see how things are made or invented”, while 23%
“strongly disagreed” with the same statement.
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In addition to items that are standard to the Common Measures, any custom items that you
created on your survey and were included in your survey data file will appear in the generated
report. Items that had numeric responses will have a figure created similar to those shown
above with the question text above the title. If you created open-ended questions, the report
may produce a graph of the comments participants gave only if it’s a small response size and
clean data. However, most qualitative data will be excluded from the repot, but a summary can
be manually added in by the creator. For most custom questions, the automatically generated
graphs will be appropriate. If your custom questions contained a very large number of possible
responses, you may need to edit the legend size or plot area of your figures. Instructions for
this process are given further in this document, under General Report Editing Tips.
When the report is generated, there is no text generated that describes the information
contained in the figures. As you view the figures you may notice results that you’d like to call to
the reader’s attention. You may want to do this by writing a summary paragraph highlighting
key findings after all the figures, or perhaps by including some text summaries following each
figure. Results that may be worthy of a note in the text include percentages that are higher
than others, e.g. “Almost all participants agreed or strongly agreed that they like science as a
result of their experience in this 4-H program” or “More than two-thirds of participants agreed
that “Being active is good for me” and “Physical activity will help me stay fit.” Results where
percentages are lower than others also might be worthy of a mention, e.g., “Only 10 percent of
participants reported that they never exercise 60 minutes a day.”
Other results that may be important to mention in text are those that relate directly to the
objectives of your 4-H program. If there are key Common Measures items that address your
curriculum specifically to highlight, such as nutrition, leadership, or community service, it might
be a good idea to highlight the results for those questions below the figures that contain those
items. You may also choose to highlight specific key results by inserting a text box, and adding
that result next to a figure. (Tips for editing reports, including adding text boxes, are included
under General Report Editing Tips.)
5. Conclusion
Following the presentation of all Common Measures survey results, a concluding section will
appear with standard text created by National 4-H. Again, you may choose to add to this text to
more fully summarize the results presented in this report. For example, you may wish to remind
the reader in this section of the results you find most interesting, e.g., X% of participants felt
they could explain why things happen in an experiment after participating in this 4-H program,
or X% of participants agreed or strongly agreed that they would eat more fruits and vegetables
after being in this 4-H program.

General Report Editing Tips
As you work through you report you may find that you wish to move or resize a figure, add a
picture, or add a text box to highlight a result in text. This section provides some tips on how
you may best do those things.
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To add a picture while editing your report, click the Insert tab, and select Picture from the
ribbon. A dialog box will open, asking you to select the image file you wish to add. Once you’ve
selected your image, click the Insert button.
To resize a graph or image, click the item you wish to resize. A number of draggable handles will
appear at the corners and sides of the item. You may click and drag these handles in order to
resize the item within the page.
To add a text box, click the Insert tab, and choose Text Box from the ribbon. A popup will offer
a number of text box styles to you. Once you have chosen one, your text box will appear within
the document. You may add notations by typing in this box, or resize it using the same
instructions given above.
To highlight text, you may select a region of text by clicking and dragging your mouse. Once
you’ve selected the appropriate region of text, you may change the colors of the selected
region using the color selection tools in the Font section of the Home tab.

Questions?
If you have questions about how to use the Common Measures Report Template or the web
application, please contact Jessie Bauman at Jbauman4@unl.edu or 402-472-2854.
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